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TERMS AND CONDITIONS 

1. INTRODUCTION TO TAXBOT.CO.ZA 

1.1 TaxBot.co.za can be accessed at https://www.TaxBot.co.za and https://taxrisk.n-abler.biz, 

related mobi-sites and software applications (the “Websites”) and is owned and operated 

by Diamond Sky Technologies (Pty) Ltd (Registration No: 2021/607203/07 (“the Company”, 

“we”, “us” and “our”). 

2. NOTICE 

2.1 These terms and Conditions (“Terms and Conditions”) govern the use of the Website and 

the Services. 

2.2 These Terms and Conditions are binding and enforceable against every person that accesses 

or uses this Website or who use the Services (“you”, “your” or “user”), including without 

limitation each user who registers as a user on https://taxrisk.n-abler. (“registered user”). 

By using the Websites and the Services, you acknowledge that you have read and agree to 

be bound by these Terms and Conditions. 

2.3 You must not use the Website or the Services if you do not agree to the Terms and 

Conditions.  The Company reserves the right to prevent your usage of this Website if you 

misuse the contents contained within this Website in any manner. The Company is the final 

arbiter as to what shall constitute misuse and its decision will be final.   

2.4 We reserve the right to amend these Terms and Conditions at any time without prior notice.  

3. TAXBOT.CO.ZA SERVICES, USER RESPONSBILITIES AND LIMITATIONS 

3.1 The purpose of TaxBot.co.za is to assist a user to identify the most relevant authority that 

they need to consider in determining the application of a tax Act quickly and accurately. 

TaxBot.co.za is a risk and research tool. Any visual representations or reports produced by 

TaxBot.co.za should only be used for this purpose. The wording used by the Bots and pricing 

are consistent with this purpose. Any representation made in the course of using a TaxBot 

referred to as “the Services” in these terms and conditions. 

3.2 As an automated generic process, TaxBot.co.za cannot collect information about all a 

taxpayer’s unique facts and circumstances. It can also not apply the necessary holistic 

judgement to those facts and circumstances to conclude or advise on the application of the 
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tax laws and regulations to those facts and circumstances. It can merely use the user’s 

responses, which inherently reflect the user’s own interpretation of some of the facts, to 

assess the relevance of various elements of the law and regulations. The content of the 

Services is intended to complement the knowledge of tax practitioners who have a working 

knowledge of South African tax legislation. The Services should only be used by such persons 

and for this purposes. If the guidance provided does not make sense or appear contrary to 

what you expected, you should immediately contact us and not use this guidance. 

3.3 TaxBot.co.za is not a tax advisor and the Services are not substitutes for the need to obtain 

professional tax advice. If you require tax advice, you should engage with a reputable and 

suitably qualified person. You can contact us at advice@TaxBot.co.za for advice. The 

operators of TaxBot.co.za do not take any responsibility for a user who relies on the outputs 

as advice or uses these outputs as if it were professional advice by a tax practitioner. 

4. CONTACTING US 

4.1 You can get in touch with us: 

4.1.1 via the contact section of this Website; or 

4.1.2 by mail or email at the addresses specified above. 

5. ACCURACY AND AVAILABILITY 

5.1 Whilst we always do our very best to ensure the information shown on the Website and as 

part of the Services is accurate and up to date, we give no warranty or undertaking as to the 

quality, or freedom from error, of the contents of this Website. We expressly exclude 

liability for any such inaccuracies or errors to the fullest extent permitted by law. 

5.2 We will use reasonable endeavours to maintain the availability of the Website and the 

Services, except during scheduled maintenance periods, and are entitled to discontinue 

providing the Website or any part thereof with or without notice to you. 

5.3 The Company may in its sole discretion terminate, suspend and modify the Website and 

Services, with or without notice to you. You agree that the Company will not be liable to you 

in the event that it chooses to suspend, modify or terminate this Website or Services. 

5.4 If you fail to comply with your obligations under these Terms and Conditions, this may (in 

our sole discretion with or without notice to you) lead to a suspension and/or termination 
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of your access to the Website without any prejudice to any claims for damages or otherwise 

that we may have against you. 

5.5 The Company is entitled, for purposes of preventing suspected fraud and/or where it 

suspects that you are abusing the Website or the Services and/or have created multiple user 

profiles to engage in any unlawful activity, to blacklist you on its database (including 

suspending or terminating your access to the Website and the Services), refuse to accept or 

process payment of any products, on notice to you. The Company shall only be liable to 

refund monies already paid by you and accepts no other liability which may arise as a result 

of such blacklisting and/or refusal. 

5.6 At any time, you can choose to stop using the Website or Services, with or without notice 

to the Company. If you are a registered member, it is your responsibility to cancel your 

subscription should you wish to do so. 

6. USE OF THE WEBSITE AND SERVICES 

6.1 It is possible to view our Website and use our Services without providing any personal 

information as defined in the Protection of Personal Information Act (“Personal 

Information”). However, if you use the “Contact Us” button or subscribe as a member, you 

will be required to provide certain Personal Information. By completing and submitting a 

“Contact Us” request on the Website, or subscribing as a member, you are expressly 

permitting the Company to collect, collate, process and use your Personal Information for 

the purpose it was provided, as well as to disclose it to our service providers (if any) and 

only if selected by you. 

6.2 We may also collect demographic and profile data on our Website. This may be combined 

with other forms of information to permit us to bring together, in aggregate form, 

information about the people who use our Website and the Services. Such information will 

enable us to understand, in general terms, user preferences in relation to the content of the 

Website and the effectiveness of the advertising. 

6.3 The Company will not share, sell or loan any identifiable information about you to any third 

party without your express consent. We may share generalised information about site 

visitor patterns with partners or other parties in such a way that individual visitors can never 

be identified. The Company will not share any information presented by you to us with third 

parties, except when required to do so by law. 
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6.4 Unfortunately, the transmission of information via the Internet is not completely secure and 

we cannot guarantee the security of data transmitted to or from our Website. Once we 

receive your information, we will use strict procedures and security measures to protect 

your information and to prevent unauthorised access to it. 

6.5 The Company is the “data controller” for purpose of the ECT Act.   

6.6 The Company will store your Personal Information in a secure hosting facility in the Republic 

of South Africa. The Company will store your Personal Information only for the purpose for 

which it was collected as well as a record of any third party to whom the Personal 

Information was disclosed, the reason for disclosure and the date of the disclosure, for the 

duration that your information is used and for a period of 1 (One) year thereafter as 

required by Section 51(5) and (7) of the ECT Act.  After the 1 (One) year period as aforesaid, 

the Company will delete or destroy (as applicable) all your Personal Information that is 

stored that has become obsolete. 

6.7 You may request details of Personal Information that we hold about you by requesting the 

Company in writing to furnish you with such information. Our security procedures mean 

that we may request proof of identity in providing you with these details, dependent on the 

Personal Information that you request. We will notify you of this after we have received 

your request. If you wish to submit a written request as outlined above then please contact 

us using the contact particulars below.  If all reasonable steps have been taken to find a 

record as requested and there are reasonable grounds for believing that the record is in the 

Company’s possession, but cannot be found, or does not exist, the head of the Company 

will by way of affirmation notify you that it is not possible to give access to that record. 

6.8 Your email address is only used for the purposes of replying to you unless you have given 

consent as detailed above.  

6.9 Whenever you browse our Website, read pages, or download information, our computers 

automatically record certain information about your visit from the computer you use to 

access our Website. This information does not identify you personally. It just tells us how 

many visitors come to our Website and the types of computers they use. With this 

information, we can improve our Website for all our visitors and make it more useful to you. 

The information includes the following: 

6.9.1 the date and time you access our Website; 
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6.9.2 how many and which pages you visit during a 'session' on our Website and how long 

you were on the Website; 

6.9.3 your Internet domain name (this might be your internet service provider such as 

aol.com or your place of work) and the 'IP' address (this is a number assigned to your 

computer whenever you are surfing the web) which allows you to access our Website;  

6.9.4 the Internet browser you use (e.g. Microsoft Explorer or Netscape) and your 

computer's operating system (e.g. Windows 10);  

6.9.5 the site you were on before you linked to our Website (e.g. Yahoo if you found us from 

a search engine).  

7. COOKIE POLICY 

7.1 WHAT IS A COOKIE? 

7.1.1 A cookie is a text-only string of information that a Website transfers to the cookie file 

of the browser on your computer's hard disk so that the Website can remember who 

you are.  

7.1.2 Cookies can help a Website to arrange content to match your preferred interests more 

quickly - most major Websites use cookies. Cookies alone cannot be used to identify 

you. A cookie will typically contain the name of the domain from which the cookie has 

come; the "lifetime" of the cookie; and a value, usually a randomly generated unique 

number.  

7.2  TWO TYPES OF COOKIES ARE USED ON OUR WEBSITE:  

7.2.1 Session Cookies, which are temporary cookies that remain in the cookie file of your 

browser until you leave the site.  

7.2.2 Persistent Cookies, which remain in the cookie file of your browser for much longer 

(though how long will depend on the lifetime of the specific cookie, how cookies are 

used on this site and what information is collected).  

7.2.3 Session Cookies are used: 
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7.2.3.1 To allow you to carry information across pages of our site and avoid having to re-

enter information.  

7.2.3.2 Within registration to allow you to access stored information.  

7.2.4  Persistent Cookies are used: 

7.2.4.1 To help us recognise you as a unique visitor (using a number, you cannot be 

identified personally) when you return to our Website.  

7.2.4.2 To allow us to tailor content or advertisements to match your preferred interests 

or to avoid showing you the same adverts repeatedly. 

7.2.4.3 To compile anonymous, aggregated statistics that allow us to understand how 

users use our site and to help us improve the structure of our Website. We cannot 

identify you personally in this way. 

7.3 Google AdWords 

7.3.1 The Company also tracks cookies by way of Google AdWords remarketing features that 

track such cookies. 

7.3.2 By visiting the Company’s Website, you agree that certain of our Google AdWords 

remarketing or other advertisements can follow you as you visit other Websites that 

are part of Google’s Display Network (GDN). 

7.3.3 We shall not share with third parties or utilise any Personal Information as obtained in 

our Google AdWords remarketing campaign in any other marketing initiatives. 

7.3.4 You may opt out of seeing advertisements for this Website by clicking here: 

http://www.google.com/policies/technologies/ads.  

7.4 THIRD PARTY COOKIES 

7.4.1 Third parties serve cookies via this Website. These are used for the following 

purposes:  

7.4.1.1 to serve advertisements on our Website and track whether these advertisements 

are clicked on by users; 
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7.4.1.2 to control how often you are shown a particular advertisement;  

7.4.1.3 to tailor content to your preferences; 

7.4.1.4 to count the number of anonymous users of our Website; 

7.4.1.5 to provide security within shopping baskets or transactions.  

7.5 WEB BEACONS 

7.5.1 Some of our web pages may contain electronic images known as Web Beacons 

(sometimes known as clear gifs) that allow us to count users who have visited these 

pages.  

7.5.2 Web Beacons collect only limited information which includes a cookie number; time 

and date of a page view; and a description of the page on which the Web Beacon 

resides.  

7.5.3 We may also carry Web Beacons placed by third party advertisers. These Beacons do 

not carry any personally identifiable information and are only used to track the 

effectiveness of a particular campaign.  

7.6 DISABLING AND ENABLING COOKIES 

7.6.1 You have the ability to accept or decline cookies by modifying the settings in your 

browser. However, you may not be able to use all the interactive features of our 

Website if cookies are disabled.  

7.6.2 Should you wish to be alerted before a cookie is accepted on your hard disk, you can 

follow the guideline instructions below: 

7.6.3 If you are using Netscape Navigator 3.0:  

7.6.3.1 Go to the 'Options' menu  

7.6.3.2 Click 'Network Preferences'  

7.6.3.3 Click 'Protocols'  

7.6.3.4 Tick the box that says 'Show an alert before accepting a cookie'  
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7.6.3.5 Go into your Netscape folder 

7.6.3.6 Delete the file that is called 'cookies.txt', this will delete all the cookies  

7.6.3.7 Under Windows 95, you should also use the 'Find' feature on the 'Start' menu to 

simply find the file called 'cookies.txt.' 

7.6.4 If you are using Internet Explorer 3.0: 

7.6.4.1 Go to the 'View' menu  

7.6.4.2 Click 'Options'  

7.6.4.3 Click 'Advanced'  

7.6.4.4 Tick the box that says 'Warn before accepting cookies' 

7.6.4.5 Go to cookies directory * Delete all the files you have there, this will delete all 

cookies  

7.6.4.6 Once you delete these files you will have no more cookies, and you will be 

prompted each time a Website attempts to send a cookie to your system. At that 

time, you can choose to either 'Accept' or 'Cancel' a cookie 

7.6.5 If you are using Netscape 4.0+:  

7.6.5.1 Go to 'Edit' in the menu bar   

7.6.5.2 Click on 'Preferences' 

7.6.5.3 Click on 'Advanced'   

7.6.5.4 Tick the box that says 'Warn me before accepting a cookie'  

7.6.5.5 Now go to your 'Start' button  

7.6.5.6 Click on 'Find'  

7.6.5.7 Click on 'Files and Folders'   

7.6.5.8 Type "cookies.txt" into the search box that appears 
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7.6.5.9 Click 'Find Now'  

7.6.5.10 When the search results appear drag all files listed into the 'Recycle Bin', this will 

delete all cookies  

7.6.5.11 Now shut down and restart Netscape  

7.6.5.12 Once you delete these files, you will have no more cookies, and you will be 

prompted each time a Website attempts to send a cookie to your system. At that 

time, you can choose to either 'Accept' or 'Cancel' the cookie 

7.6.6 If you are using Internet Explorer 5.0+:  

7.6.6.1 Go to the 'Tools' menu   

7.6.6.2 Click on 'Internet Options'  

7.6.6.3 Click the 'Security' tab  

7.6.6.4 Highlight the 'Internet' zone (selected by default)  

7.6.6.5 Select security level 'High' for this zone  

7.6.6.6 Click on 'OK'   

7.6.6.7 Go into your cookies directory  

7.6.6.8 Delete all the files you have there, this will delete all cookies   

7.6.6.9 Once you delete these files, you will have no more cookies and your browser will 

no longer send or receive new cookies.  

7.6.7 If you are using Netscape 6.0+:  

7.6.7.1 Go to 'Edit' in the menu bar  

7.6.7.2 Click on 'Preferences'  

7.6.7.3 Select the 'Cookies' field  

7.6.7.4 Before Accepting a Cookie' or 'Disable Cookies'  
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7.6.7.5 Click on 'OK'  

7.6.7.6 Go to your 'Start' button  

7.6.7.7 Click on 'Files and Folders'  

7.6.7.8 Type "cookies.txt" into the search box that appears  

7.6.7.9 Click 'Find Now'   

7.6.7.10 When the search results appear drag all files listed into the 'Recycle Bin', this will 

delete all cookies  

7.6.7.11 Now shut down and restart Netscape  

7.6.7.12 Depending on your earlier choice you will either be prompted by new cookies or 

no cookies will be set or received 

7.6.8 If you are using Internet Explorer 6.0+:  

7.6.8.1 Go to the 'Tools' menu  

7.6.8.2 Click on 'Internet Options'  

7.6.8.3 Click the 'Privacy' tab  

7.6.8.4 Move the slider to choose your preferred settings  

7.6.8.5 Click on 'OK'  

7.6.8.6 Go into your cookies directory  

7.6.8.7 Delete all the files you have there, this will delete all cookies  

7.6.8.8 Once you delete these files, you will have no more cookies and your browser will 

no longer send or receive new cookies 

7.6.9 If you are using Netscape 7.0+:  

7.6.9.1 Go to 'Edit' in the menu bar   

7.6.9.2 Click on 'Preferences'  
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7.6.9.3 Click on ' Privacy & Security'  

7.6.9.4 Select the 'Cookies' field  

7.6.9.5 Choose your preferred settings  

7.6.9.6 Go to your 'Start' button  

7.6.9.7 Click on 'Find'  

7.6.9.8 Click on 'Files and Folders'  

7.6.9.9 Type "cookies.txt" into the search box that appears  

7.6.9.10 Click 'Find Now'   

7.6.9.11 When the search results appear drag all files listed into the 'Recycle Bin', this will 

delete all cookies Now shut down and restart Netscape  

7.6.9.12 Depending on your earlier choice you will either be prompted by new cookies or 

no cookies will be set or received 

7.7 DELETING COOKIES  

You can easily delete any cookies that have been installed in the cookie folder of your 

browser. For example, if you are using Microsoft Windows Explorer:  

7.7.1  Open 'Windows Explorer'  

7.7.2 Click on the 'Search' button on the tool bar  

7.7.3 Type "cookie" into the search box for 'Folders and Files'  

7.7.4 Select 'My Computer' in the 'Look In' box  

7.7.5 Click 'Search Now' * Double click on the folders that are found  

7.7.6 'Select' any cookie file  

7.7.7 Hit the 'Delete' button on your keyboard  
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7.7.8 If you are not using Microsoft Windows Explorer, then you should select "cookies" in 

the "Help" function for information on where to find your cookie folder. 

8. DATA PROTECTION ON PIXEL TAGS  

8.1 We may use "pixel tags," which are small graphic files that allow us to monitor the use of 

our Websites.  

8.2 A pixel tag can collect information such as the IP (Internet Protocol) address of the computer 

that downloaded the page on which the tag appears; the URL (Uniform Resource Locator) 

of the page on which the pixel tag appears; the time the page containing the pixel tag was 

viewed; the type of browser that fetched the pixel tag; and the identification number of any 

cookie on the computer previously placed by that server. 

8.3 When corresponding with you via HTML capable e-mail, we may use "format sensing" 

technology, which allows pixel tags to let us know whether you received and opened our e-

mail. 

9. JURISDICTION AND LAW 

9.1 This Website and Services is intended for the use of our Clients in the Republic of South 

Africa only. It was created and is operated according to the laws of the Republic of South 

Africa.  

9.2 These terms and our relationship and/or any dispute arising from or in connection with 

these terms will be governed and interpreted in accordance with the laws of the Republic 

of South Africa. Your continued use of the Website and the Services will constitute your 

consent and submission to the jurisdiction of the South African courts regarding all 

proceedings, transactions, applications or the like instituted by either party against the 

other, arising from any of these terms. 

9.3 Nothing within these terms is intended to, nor will it, limit your right to approach any court, 

tribunal or forum of competent jurisdiction in terms of the Consumer Protection Act. 

10. CHANGES TO THE TERMS AND CONDITIONS 

10.1 The Company may, in its sole discretion, change any of these Terms and Conditions at any 

time. It is your responsibility to regularly check these Terms and Conditions and make sure 
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that you are satisfied with the changes. Should you not be satisfied, you must not in any 

way continue to use the Website or the Services. 

10.2 Any such change will only apply to your use of this Website after the change is displayed on 

the Website. If you use the Website after such amended Terms and Conditions have been 

displayed on the Website, you will be deemed to have accepted such changes. 

11. UNDERTAKINGS  

11.1 You are permitted to browse this Website and use the Services. We also encourage you to 

download and share elements with your friends and family for personal and information 

use. However, you are not allowed to reproduce extracts by way of printing, downloading 

or by distribution to other people for business use, or create any hyperlink or other similar 

form of connection to this Website without our express written permission. The use of this 

Website within any other Website by the use of framing or otherwise is strictly prohibited. 

11.2 You agree that you will not in any way use any device, software or other instrument to 

interfere or attempt to interfere with the proper working of the Website. In addition, you 

agree that you will not in any way use any robot, spider, other automatic device, or manual 

process to monitor, copy, distribute or modify the Website or the information contained 

herein, without the prior written consent from an authorised the Company representative 

(such consent is deemed given for standard search engine technology employed by Internet 

search Websites to direct Internet users to this Website). 

12. COPYRIGHT 

12.1 The contents of the Website and any documents or information generated in the course of 

rendering the Services, including any material, information, data, software, icons, text, 

graphics, lay-outs, images, sound clips, advertisements, video clips, trade names, logos, 

trade-marks, designs and service marks which are displayed on or incorporated in the 

Website (“Content”) are protected by law, including but not limited to copyright and trade 

mark law. The Website Content is the property of the Company, its advertisers and/or 

sponsors and/or is licensed to the Company. 

12.2 You will not acquire any right, title or interest in or to the Website or the Website Content. 

12.3 Any use, distribution or reproduction of the Website Content is prohibited unless expressly 

authorised in terms of these Terms and Conditions or otherwise provided for in law.  
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12.4 Where any of the Website Content has been licensed to us or belongs to any third party, 

your rights of use will also be subject to any terms and conditions which that licensor or 

third party imposes from time to time and you agree to comply with such third party terms 

and conditions. 

13. DISCLAIMER 

13.1 The use of the Website and the Services is entirely at your own risk and you assume full 

responsibility for any risk or loss resulting from use of the Website or Services or reliance 

on any information on the Website or Services. 

13.2 Whilst the Company takes reasonable measures to ensure that the content of the Website 

and Services is accurate and complete, the Company makes no representations or 

warranties, whether express or implied, as to the quality, timeliness, operation, integrity, 

availability or functionality of the Website or as to the accuracy, completeness or reliability 

of any information on the Website. If any such representations or warranties are made by 

the Company’s representatives, the Company shall not be bound thereby. 

13.3 The Website and Services itself and all information provided is provided “as is” without 

warranty of any kind, either express or implied, including, but not limited to, the implied 

warranties of merchantability, fitness for a particular purpose, completeness, or non-

infringement, as may be allowed in law. 

13.4 Any views or statements made or expressed on the Website or in the course of rendering 

the Services are not necessarily the views of the Company, its directors, employees and/or 

agents. 

 


